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 Legal Notices 
ContentWatch, Inc. makes no representations or warranties with respect to the contents or use of this 
documentation, and specifically disclaims any express or implied warranties of merchantability or fitness for any 
particular purpose. Further, ContentWatch, Inc. reserves the right to revise this publication and to make changes 
to its content, at any time, without obligation to notify any person or entity of such revisions or changes. 

Further, ContentWatch, Inc. makes no representations or warranties with respect to any software, and 
specifically disclaims any express or implied warranties of merchantability or fitness for any particular purpose. 
Further, ContentWatch, Inc. reserves the right to make changes to any and all parts of ContentWatch software, 
at any time, without any obligation to notify any person or entity of such changes. 

You may not use, export, or re-export this product in violation of any applicable laws or regulations including, 
without limitation, U.S. export regulations or the laws of the country in which you reside. 

Copyright © 2002-2007 ContentWatch, Inc. All rights reserved. No part of this publication may be reproduced, 
photocopied, stored on a retrieval system, or transmitted without the express written consent of the publisher. 

ContentWatch, Inc. 
2369 West Orton Circle 
Salt Lake City, Utah 84119 U.S.A. 

www.contentwatch.com 

ContentWatch Trademarks 
ContentWatch is a trademark of ContentWatch, Inc. in the United States and other countries. 

ContentProtect is a trademark of ContentWatch, Inc. in the United States and other countries. 

ContentProtect Professional is a trademark of ContentWatch, Inc. in the United States and other countries. 

Net Nanny is a trademark of ContentWatch, Inc. in the United States and other countries. 

Third-Party Materials 
All third-party trademarks are the property of their respective owners. 
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 Welcome to Net Nanny 
Welcome to Net Nanny™, the most comprehensive and easily adaptable Internet filtering software available 
today. Net Nanny comes preset to protect you from objectionable and inappropriate content. However, because 
not all users are alike, Net Nanny also allows you to modify the filter settings so you can customize Net Nanny to 
suit your individual usage needs. 

The following resources are available to help you use Net Nanny: 

 Net Nanny Parental Controls User Guide (PDF format) is available from the Net Nanny Help menu. It 
provides the following information: 
o Step-by-step instruction 
o Net Nanny category list with descriptions 
o Glossary 
o FAQ (Frequently Asked Questions) 

 An online help system is available from the Net Nanny Help menu. It provides step-by-step instruction 
and Web-based reporting. 

 Customer Support is provided at 1-800-485-4008 for questions and technical assistance. Customer 
Support is available Monday through Friday, 8 a.m. to 5 p.m., Mountain Standard Time. 

 Web-based Customer Support is available any time at info@contentwatch.com. 

Documentation Conventions 

A trademark symbol (®,™, etc.) denotes a ContentWatch™ trademark. An asterisk (*) denotes a third-party 
trademark. 

 System Requirements and Key Features 
System Requirements 

 PC or compatible 133 MHz or faster processor 
 Microsoft* Windows* 2000/XP 
 128 MB RAM minimum, 256 MB RAM recommended 
 25 MB hard drive space 
 CD-ROM drive 
 Color monitor with a minimum 800x600 resolution 
 Internet connection 
 Internet Explorer 4.0 or later, Netscape* 6.0 or later, or other current Web browser 

 

Key Features 
 User-friendly interface 
 Client-based filtering 
 Unique and portable user profiles 
 Web-based drill-down reports 
 Override options 
 Remote user management 
 Email notifications 

mailto:info@contentwatch.com
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 Installing Net Nanny 

Important: You must have an Internet connection to install Net Nanny™. If you have a dial-up connection, you 
should connect to the Internet before installing.  

To install Net Nanny: 

1. Double-click the Net Nanny icon  to launch the installation. 

2. Select the language you prefer to use during setup and installation from the drop-down menu, then click 
OK. 

 
 

3. When the Net Nanny Setup Wizard launches, close all other applications before continuing with the 
installation (as recommended), then click Next to continue. 

 
 

4. When the Warning screen appears, make sure your firewall (if you have one) is configured so that Net 
Nanny can access the Internet, then click Next to continue. 
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5. At the License Agreement window, carefully review the License Agreement, select I accept the 

agreement, then click Next to continue.  

 
 

6. Enter your registration number, then click Next to continue.  

If you purchased Net Nanny online or requested a trialware number, the registration number was sent to 
you via email. If you purchased Net Nanny in a store, the registration number came with your CD.  

 
 

7. (Conditional) If you are installing and registering Net Nanny for the first time, skip to Step 9. 
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8. (Conditional) If you purchased multiple Net Nanny licenses and you are now installing an additional 
instance of the Net Nanny client, or if you only have one license and you are reinstalling Net Nanny, do 
the following: 

a. Enter the email address and password you used to initially register Net Nanny. 

 
b. Click Next. 

c. Skip to Step 12. 

9. Enter your email address, then click Next to continue.  
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10. Assign the password you want to use for the Net Nanny administrator account, then click Next to 
continue. 

 
Passwords are not case sensitive and are limited to between 3 and 13 characters in length. Alpha and 
numeric characters can be combined. 

 
 
11. Provide a Secret Question and Answer, then click Finish. 

If you forget your password, Net Nanny prompts you with the Secret Question. You must enter the 
correct answer before Net Nanny allows you to change the administrator account password. 
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12. Select the location where you would like to install Net Nanny, then click Next.  

The default location is C:\Program Files\ContentWatch. To choose a different location, click Browse and 
browse to the new location.  

 

13. At the Ready to Install window, click Install to begin the installation. 

 
Net Nanny is installed at the designated location and program modules are registered. 

 
14. Click Restart to complete the Net Nanny installation and setup.  

Your computer automatically shuts down and restarts. 
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After your computer restarts, the following occurs: 

• Net Nanny validates that the installation was successful and that Net Nanny is functioning 
correctly. 

 

• A Net Nanny icon  appears in the system tray located on the taskbar at the bottom of your 
Windows desktop. 

 
15. If the installation was successful and Net Nanny is functioning correctly, click OK on the Success prompt 

that appears. 
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 The Net Nanny Systray Icon 
The Net Nanny icon  resides in the Windows system tray to give you quick right-click access to the following:  

• Net Nanny Admin Tools  
• Net Nanny log  
• Manual check for updates 
• Profile refresh 
• Disable Net Nanny 

 

If you would like to prevent users from accessing Net Nanny features using the systray icon, you can choose to 
hide the icon.  

 

Hiding and Displaying the Net Nanny Systray Icon 
To hide or display the Net Nanny systray icon: 

1. Select Start > Programs > ContentWatch > Net Nanny Parental Controls > Net Nanny.  

2. Log in to Admin Tools with an administrator name and password. 

3. From the Tools menu, select Hide Systray Icon to hide or display the Net Nanny Systray icon. 

This option is a toggle switch. If a checkmark appears to the left of the Hide Systray Icon option, the Net 
Nanny icon displays in the systray.  Conversely, if there is no checkmark to the left of the Hide Systray 
Icon option, the Net Nanny icon does not display in the systray.  

 

  
 

Net Nanny systray icon 
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 Signing In to Net Nanny 
Net Nanny™ is automatically installed in Default Mode. This means that users are able to access the Internet 
and instant messaging without signing in to Net Nanny. Default Mode provides ease-of-use; however, it does not 
separately monitor each user’s Internet usage, and filters are unilaterally applied to all users.  

In User Mode, users must sign in to their Net Nanny accounts before they are able to use the Internet for 
browsing or instant messaging. This allows Net Nanny to monitor each user’s Internet usage and block content 
on a per-user basis.  

Note: To enable User Mode, the administrator must first log in to the Net Nanny Admin Tools, select the Users 
option under User Login Type, then create individual user accounts for each user on the system. For more 
information on enabling User Mode and defining user accounts, see Enabling User Mode on page 26 and 
Defining User Profiles on page 27. 
 
 
If User Mode is enabled, you must sign in to Net Nanny before you can access the Internet or instant messaging. 
If you do not sign in manually, you are prompted to sign in when you attempt to use the Internet. 

To sign in manually: 

1. Right-click the Net Nanny icon  in the system tray located on the taskbar at the bottom of your 
Windows desktop, then select Admin Tools from the quick menu.  

Note: If you do not see the Net Nanny icon in the system tray, the icon may be hidden. For instructions 
on displaying the icon, see Displaying the Net Nanny Systray Icon on page Error! Bookmark not 
defined.. 

 
 

2. Select your user name from the drop-down menu, enter your password, then click OK.  
 
If you don’t know your password, ask the administrator. 

Note: Asterisks (*) appear as you type your password to protect it from being viewed. 
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You are now signed in as a user. Launch your Internet browser and proceed with regular Internet activity. For 
information about the possible block and warning messages you might receive, see Block and Warning 
Messages on page 37.  
 
When you finish your Internet or instant messaging session, we recommend you sign out of Net Nanny.  
 
Warning: If you leave your computer without signing out of Net Nanny, other users have access to the Internet 
under your sign-in name and also to your Web and instant message privileges. This also means that their Web 
and instant message activity is logged under your name. However, if Inactive User Logout is enabled, you are 
logged out according to the time settings configured by the administrator.  
 
To sign out of Net Nanny: 

1. Right-click the Net Nanny icon  located in the system tray on the taskbar at the bottom of your 
Windows desktop. 

2. Select Logout from the quick menu.  

 
 
Note: If you shut down your computer without signing out, your session automatically ends. You must sign in 
again when the computer restarts. 
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 Updating Net Nanny with Online Updates 
Online updates allow you to update Net Nanny™ with the latest software updates. There are three methods for 
updating Net Nanny: Manual (default), Automatic, and Password Protected. 

Manual Updates 
To manually update Net Nanny:  

1. Make sure Net Nanny is configured to perform manual updates. 

a. Sign in to Net Nanny’s Admin Tools. 
For instructions on how to do this, see Opening the Net Nanny Admin Tools on 
page 22. 

b. From the Tools menu, select Updates > Manual. 

 

c. Close the Admin Tools. 

2. Right-click the Net Nanny icon  in the system tray. 

Note: If you do not see the Net Nanny icon in the system tray, the icon may be hidden. For instructions 
on displaying the icon, see Displaying the Net Nanny Systray Icon on page Error! Bookmark not 
defined.. 

3. Select Check For Updates from the quick menu. 
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4. At the ContentWatch Updater screen, click Next. 

  
If there are no new updates, Net Nanny indicates that no new updates are available.  

If Net Nanny updates are available, a wizard appears and steps you through the process of downloading 
and installing the updates. If you choose to download and install the updates, you may be asked to 
restart your computer for the changes to take effect. 

Note: When Net Nanny is in Manual Update Mode, it displays a notification in the system tray when an 
online update becomes available. You can simply click on this notification to initiate the update process. 
 

Automatic Updates 
To configure Net Nanny to automatically update itself:  

1. Sign in to the Net Nanny Admin Tools. 
For instructions on how to do this, see Opening the Net Nanny Admin Tools on 
page 22. 

2. From the Tools menu, select Updates > Automatic. 

 

3. Close the Admin Tools. 

Net Nanny is now enabled to perform the update process automatically. No user input is required. 
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Password-Protected Updates 
To require an administrative password in order to update Net Nanny:  

1. Sign in to the Net Nanny Admin Tools. 
For instructions on how to do this, see Opening the Net Nanny Admin Tools on page 22. 

2. From the Tools menu, select Updates > Password Protected. 

 

3. Close the Admin Tools. 
 

Net Nanny is now configured to prompt for a Net Nanny administrator password whenever a user attempts to 
manually update the software. 
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 Changing User Passwords 
Users can quickly change their own Net Nanny login passwords. 

To change a password: 

1. Make sure you are logged in to Net Nanny with your own user name. 

2. Right-click the Net Nanny icon  in the system tray. 

3. Select Change Password from the quick menu. 

  

4. Enter the old password and the new password in the appropriate fields, retype the new password to 
confirm it, then click OK. 

  

The password is immediately changed in the local Net Nanny database, and the updated information is 
sent to the Net Nanny server. 
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 Disabling Net Nanny  
There may be times when you want to temporarily disable Net Nanny™--for example, you might want to 
temporarily allow access to the Internet without blocking any content or you might want to allow a non-safe 
search in one of the supported search engines. Rather than temporarily changing the current user’s policies, you 
should temporarily disable Net Nanny. 

To temporarily disable Net Nanny: 
1. Right-click the Net Nanny icon  in the system tray. 

 Note: If you do not see the Net Nanny icon in the system tray, the icon may be hidden. For instructions 
on displaying the icon, see Displaying the Net Nanny Systray Icon on page Error! Bookmark not 
defined.. 

2. Select Disable Net Nanny from the quick menu. 

  
 
3. Enter the administrator’s password, then click OK. 

  

4. Choose whether you want the client to automatically re-enable itself or remind you that it is disabled after 
a certain amount of time has passed. 
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5. Select the amount of time until the client re-enables itself or gives you a reminder (After Reboot, 
5 Minutes, 10 Minutes, 15 Minutes, 20 Minutes, 25 Minutes, 30 Minutes, or 1 Hour). 

 

6. Click OK. 

Net Nanny is now disabled. 

 

To re-enable Net Nanny: 

1. Right-click the Net Nanny icon  in the system tray. 

2. Select Enable Net Nanny. 
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 Introduction to the Net Nanny Local Admin Tools 
You must have an administrator account to open Net Nanny™ Admin Tools. Within these tools, you can 
customize user profiles, define filter settings, and monitor user activity. 

Opening the Net Nanny Admin Tools 
To open the Net Nanny Admin Tools: 

1. Right-click the Net Nanny icon  in the system tray located on the taskbar at the bottom of your 
Windows desktop, then select Admin Tools from the quick menu.  

 Note: If you do not see the Net Nanny icon in the system tray, the icon may be hidden. For instructions 
on displaying the icon, see Displaying the Net Nanny Systray Icon on page Error! Bookmark not 
defined.. 

 
You can also select Start > Programs > ContentWatch > Net Nanny Parental Controls > Net Nanny. 

Note: When you log in to the Admin Tools for the first time after installing and registering Net Nanny, you 
are prompted to choose the user login type you want to use. Choose the desired login type, then click 
OK. See Signing In to Net Nanny on page 14 for more information on user login types. 
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2. Select your administrator name from the drop-down menu, enter your password, then click OK.  

 
Asterisks (*) appear as you type your password to protect it from being viewed. 

Note: If you cannot remember your administrator password, click Forgot Password. Your Web browser 
launches and takes you to the ContentWatch Web site, where you are asked to enter the email address 
you specified when installing Net Nanny. An email is then sent to this address. The email contains a link 
to a Web page that asks you the secret question you entered when you installed Net Nanny. Type the 
secret answer, and you are then allowed to change your password for this account. 

 

 Once you have logged in, the Net Nanny Admin Tools window appears: 

  
 
Important: We recommend that you do not leave the Net Nanny Admin Tools open if you walk away from your 
computer because other users will have full access to all the program’s administrator settings. 
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Closing the Net Nanny Admin Tools 
To close the Net Nanny Admin Tools, select File > Exit. 

 
 
Note: Closing the Net Nanny Admin Tools does not disable Net Nanny. User accounts, profiles, and content 
filters are still active. 
 
Overview of the Net Nanny Admin Tools Interface 
The following is an overview of the layout of the Net Nanny Admin Tools interface. Details about how to use the 
Admin Tools to configure specific settings are provided in subsequent sections of this user guide. 

 

  

 

User Settings 
(individual users’ 
profile information 

and Internet 
access settings 
are configured 

here) 

Menu Bar 

User List 
(users are 
added and 

removed here) 

Family Settings 
(settings that 

apply globally to 
all users are 

configured here) 



 

 
ContentWatch, Inc. / Net Nanny Parental Controls User Guide 

 Page 25 

 Setting the Time Zone 
To ensure that the Net Nanny time-related features (such as Time Controls and Reports) work correctly, you 
must specify your time zone. 
 
To set the time zone: 

1. Sign in to the Admin Tools.  

2. From the Tools menu, select Time Zone. 

  
 The Time Zone dialog appears. 
 
3. From the drop-down list, select your time zone. 

  

4. Click OK.  
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 Enabling User Mode 
Net Nanny™ is automatically installed in Default Mode. This means that users can access the Internet and 
instant messaging without signing in to Net Nanny. Default Mode provides ease-of-use; however, it does not 
monitor each user’s Internet activity separately, and it does not allow filters to be customized for individual users.  

In User Mode, users must sign in to their Net Nanny accounts before they can use the Internet for browsing or 
instant messaging. Net Nanny can then keep track of each user’s Internet activity and can block content on a 
per-user basis. 
 
To enable User Mode: 

1. Sign in to the Admin Tools.  

2. Under Family Settings, click User Login Type. 

  
 
3. Select Users, then click OK. 

  
Net Nanny is now in User Mode. Users must sign in to their Net Nanny accounts before they can use the 
Internet for browsing or instant messaging.  

Important: After you enable User Mode, you must create a user profile for each user on the system. For 
more information, see Defining User Profiles on page 26. 
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 Managing User Profiles 
A user profile is an account created for a system user. The user profile can be used to apply custom filters to 
individual users and to track each user’s Internet usage.  

Important: If Net Nanny™ is in User Mode, each user must have a profile before being able to use the Internet 
for browsing or instant messaging. 
 
 

Defining User Profiles 
1. Sign in to the Admin Tools. 

2. Under the Users list, click Add. 

  
 
3. From the Duplicate Settings From drop-down menu, select Factory User. 

  
4. Complete the user profile information (user name, email address, password, etc.), then click OK. 

For a description of the options in the Add User dialog, see User Profile Options on page 28.  

After you create the user profile, you can define the filter settings and time controls for the user. For more 
information, see Managing Filter Settings on page 34 and Managing Time Controls on page 41. 
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User Profile Options 
The following table outlines the user profile options: 
 

Field Description 

User Name The name the user enters to sign in to Net Nanny. 

User names must be between 2 and 20 characters in length. 

 

Email The user’s email address.  

This field is required only if the user is an administrator. 
 

Password The password the user enters to sign in to Net Nanny.  

Passwords must be between 3 and 13 characters in length. Passwords are case sensitive. 
Numbers and alpha characters can be combined. 

Passwords are required only for administrators. If you prefer not to have a password for a user, or 
if a user is too young to type in a password, leave the password field blank. 

Note: We recommend you keep a list of passwords and the corresponding user names in a safe 
place for reference. However, the administrator can change a password for any user, at any time, 
which should eliminate the fear of losing or forgetting passwords for access. 

 

Inactive User 
Logout 

Designates an inactivity threshold after which the user is automatically logged out. 

If you select Never, Net Nanny does not automatically log out the user. 

 

Auto Windows 
Login 

Select this option if you want Net Nanny to employ a user's Windows login credentials to 
automatically log in to their personal Net Nanny profile for Internet access. From the Auto 
Windows Login drop-down list, select the Windows account you want to associate with the user's 
Net Nanny profile. Once this association has been made, the user only has to log in to Windows 
and should not be prompted to log in to Net Nanny separately. 
 
Please be aware that this association is not automatically synchronized to other computers in your 
household. If a family member has Windows accounts on multiple computers, you must configure 
the Auto Windows Login option for that user on each computer. 
 
Note: If you set up a user's Net Nanny profile to have the same name as the user's Windows 
account, and you selected the Auto Windows Login option in the Net Nanny Remote Management 
tool on the Web, Net Nanny attempts to create an association between the Windows account and 
the Net Nanny profile upon the first login attempt. For example, if the Auto Windows Login option 
is selected in Remote Management and the user name "JohnD" exists in the Net Nanny user list, 
a user who logs in to Windows as "JohnD" is automatically logged in to Net Nanny without having 
to specify a Net Nanny user name and password the first time they log in to the computer. 
 
Note: We recommend that filter settings for password-free profiles be more restrictive than user 
profiles that require passwords. 

Auto Client 
Login 

Select this option if you want Net Nanny to remember the profile's user name and password and 
to automatically log in to Net Nanny using this profile whenever a user attempts to access Internet 
content. 
 
When this option is selected, you only need to log in to Net Nanny once. Thereafter, Net Nanny no 
longer prompts for login credentials when users attempt to access Internet content, even if the 
computer is rebooted. Net Nanny continues to remember the user name and password until 
someone manually logs off the Net Nanny profile. 
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Field Description 
 
Note: The Auto Client Login option is useful when you want to monitor and manage Internet 
activity for a single computer rather than specific users. For example, if you have a computer in 
your living room and you want to use the same Net Nanny filter settings, time controls, and so 
forth to control Internet access for anyone who uses that computer. You can create a Net Nanny 
profile named "Living Room," configure profile settings as desired, and then enable the Auto Client 
Login option so that users are automatically logged in to Net Nanny whenever they start that 
computer and try to access the Internet. 

Administrator Select this option to give the user administrative privileges.  

Users with administrative privileges can change passwords, profile settings, and filters; receive 
email notifications; and access reporting and remote management. 

Override 
Blocked 
Messages 

Select this option if you want the user to be able to override blocked content. If selected, Net 
Nanny prompts the user for the override password when it blocks Internet content. (For an 
example of this message, see Block and Warning Messages on page 37.) 

Important: The user must enter the override password before Net Nanny displays the blocked 
content. The override password is created during installation and can be changed at any time via 
the Passwords dialog. 

If you do not select this option, Net Nanny displays a block message when the user tries to access 
blocked Internet content. 

 

Request 
Overrides 

Select this option to allow users to submit requests to Net Nanny administrators to unblock or 
recategorize specific Web pages or entire Web sites that fall under a blocked category or a 
warning category in the Admin Tool’s filter settings. (For examples of the messages displayed to 
users, see Block and Warning Messages on page 37. For information on how the administrator 
can respond to override requests, see Processing User Override Requests on page 50.) 
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Duplicating a User Profile 
Net Nanny allows you to duplicate settings from existing user profiles to create new user profiles. When you 
duplicate a user profile, the filter settings and time controls for the selected profile are applied to the new profile.  

To create a new user profile based on an existing profile: 

1. Sign in to the Admin Tools. 

2. Under the Users list, click Add. 

3. From the Duplicate Settings From drop-down menu, select the user profile you want to duplicate for 
the new user. 

 
4. Complete the user profile information, then click OK. 

For a description of the options in the User Profile dialog, see User Profile Options on page 28.  

After you create the user profile, you can customize the user’s filter settings and time controls. For more 
information, see Managing Filter Settings on page 34 and Managing Time Controls on page 41. 

Assigning Administrative Privileges to a User Profile 
The primary administrator account is created during installation. This administrator profile is permanent and 
cannot be changed; however, you can assign administrative privileges to other users.  

To assign administrative privileges to an existing user profile:  

1. Sign in to the Admin Tools. 

2. From the User List, select an existing user, then click Profile Settings. 

In Default Mode, this option is named Administrator Settings. When running in Default Mode, the only 
available profile settings are the settings for the administrator account. 
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3. Select the Administrator option to give administrative privileges to this user.  

  
 
4. Click OK to save the changes. 

Modifying a User Profile 
There may be circumstances when you need to change existing user profiles. For example, you may want to 
change the user password, update the user email address, and so forth.  

To modify an existing user profile:  

1. Sign in to the Admin Tools. 

2. From the User List, select an existing user, then click Profile Settings. 

In Default Mode, this option is named Administrator Settings. When running in Default Mode, the only 
available profile settings are the settings for the administrator account. 

3. Modify the user profile settings, then click OK to save your changes.  

For a description of the options in the User Profile Settings dialog, see User Profile Options on page 28. 

Changing Passwords 
Net Nanny allows administrators to change user passwords without having to provide the user’s current 
password. 

To change a user’s password:  

1. Sign in to the Admin Tools. 

2. From the User List, select an existing user, then click Profile Settings. 

In Default Mode, this option is named Administrator Settings. When running in Default Mode, the only 
available profile settings are the settings for the administrator account. 

3. Enter the new password and confirm.  

Note: Passwords are case sensitive and must be between 3 and 13 characters in length. Numbers and 
letters can be combined.  

4. When finished, click OK to save your changes. 
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If you forget the primary administrator password, you can do any of the following: 

• If you have more than one administrator account, another administrator can change your password for 
you by logging in to Admin Tools, selecting the user from the User List, and changing the password in 
the Profile Settings dialog. 

• At the Admin Tools login screen, click Forgot Password. Your Web browser launches and takes you to 
the ContentWatch™ Web site where you are asked to enter the email address you specified when 
installing Net Nanny. An email is then sent to this address containing a link to a Web page that asks you 
the secret question you entered when you installed Net Nanny. Type the secret answer, and you are 
then allowed to change your password for this account. 

• Select Remote Management from the system tray icon and, in the Web page that appears, click Forgot 
Password. You are prompted to enter the email address you specified when installing Net Nanny. An 
email is then sent to this address containing a link to a Web page that asks you the secret question you 
entered when you installed Net Nanny. When you type the secret answer, you are then allowed to 
change your password for this account. 

• Send a Password Request to info@contentwatch.com or call Customer Support at 1-800-485-4008. 
You must provide the following information to change the primary administrator password: 
o Administrator name 
o Registration key 
o Account name 
o Email address (where to send password) 
o Secret question and answer 

Deleting a User Profile 
Net Nanny allows users with administrator rights to delete existing user profiles. 

Warning: This action cannot be undone. If a user profile is accidentally deleted, it cannot be restored. If you 
want to restore the account, you must create it again.  

To delete an existing user profile: 

1. Sign in to the Admin Tools. 

2. From the User List, select an existing user, then click Remove. 

3. Click OK to confirm the deletion. 

 NOTE: Deleting a user also permanently deletes his or her activity data. The user’s Internet and instant 
messaging activities no longer appear in reports. 

mailto:info@contentwatch.com
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 Configuring Email Notifications 
Email notifications can be sent to the administrator or other users to provide alerts about users who are blocked 
or warned or who override blocks. 

To configure email notifications: 

1. Sign in to the Admin Tools. 

2. Under Family Settings, click Email Notifications. 

3. In the Send Email To field, type the email address where you want to send notification messages. 

 
 

4. From the Send Email When drop-down list, select the user that you want to receive notification 
messages about:  
• If your system is in Default Mode, select either Users in Default Mode or All Users.  
• To receive notification for a specific user’s activity, select the desired user profile.  
• To receive notification for all users, select All Users.  

5. Decide if you want a notification sent when the user is blocked or warned, or if the user overrides a block 
or requests an override. You can select multiple options. 

6. Click Add to save the notification to the Notification List. 

7. Repeat Steps 3 through 6 for each notification you want to add to the Notification List.  

8. To remove a notification, select the notification in the Notification List, then click Delete. 

9. When finished, click OK. 
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 Managing Filter Settings 
Filter settings are used to control Internet activity (browsing), instant messaging (Yahoo!*, AOL*, MSN*, QQ*, 
Google Talk*), newsgroups, peer-to-peer access, and network gaming. These services can be individually 
allowed or blocked for each user in the User List.  
 

   
 

 
 
If the Override Blocked Messages option is selected in the User Profile Settings dialog, the user can override 
blocked categories with the override password. The user must enter the override password before Net Nanny™ 
displays the blocked content.  
 
Note: The override password is created during installation and can be changed in the Passwords dialog. 

Defining User Filter Settings 
Filter settings determine the level of access users have to predefined Internet content categories. User access to 
these sites can be set to Allow, Warn, or Block: 

Allow: Provides access without restriction. No message is displayed and the user is allowed access to 
the requested page. The action is logged (if logging is enabled for this user). 

Warn: Provides access but warns the user of the types of content about to be viewed and lists the 
category types that caused the warning. A warning message is displayed and the user can choose to 
view the requested page. The action is logged (if logging is enabled for this user). 

Block: Prompts the user that the Web site is being blocked and lists the category types that have 
blocked it. The requested page does not open unless the user has the privilege to override the block and 
does so. The action is logged (if logging is enabled for this user). 

 
Note: For message examples and descriptions, see Block and Warning Messages on page 37. 
 
 

Select 
User 

Filter 
Settings Settings: Allow, 

Warn, Block 

Allow Access To 
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To define a user’s filter settings:  

1. Sign in to the Admin Tools. 

2. From the User List, select an existing user profile. Click Filter Settings.  

In Default Mode, click Filter Settings.  

3. Do one of the following: 

• Select Allow, Warn, or Block from the drop-down list for each content category whose setting you 
want to change: 

        
• Select a setting from the Reset All Categories To drop-down list, then click Reset to change all 

content categories to the same setting: 

        
The following categories are blocked by default: 
 Adult/Mature 
 Pornography 
 Drugs/Alcohol 
 Gambling 
 Hate/Violence 
 Illegal Activities 
 Intimate Apparel 

All other categories are set to Allow. For a listing of Net Nanny categories and descriptions, see Content 
Categories on page 35. 

4. When finished, click OK to apply your settings.  

 

Content Categories 
To help you filter Internet content, Net Nanny provides a list of predefined content categories. You can choose to 
Allow, Warn, or Block URLs that fall within these categories.  

Note: For information on defining filter settings, see Defining User Filter Settings on page 34. 

The following table outlines the Net Nanny predefined content categories:  

 

Category Description 

 Ads Advertisements. Note: Because advertisements are commonly embedded in other 
types of content on the Internet, blocking or warning this category can cause 
undesirable effects. 

 Adult/Mature Sites or resources that contain subject matter intended for mature audiences, such as 
obscene or vulgar language and adult instant message rooms. These sites could be 
considered R-rated. 

 Chat Site Sites or resources that contain information on instant message protocols or applications 
and links to instant message organizations, rings, and rooms. 
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Category Description 

 Drugs/Alcohol Sites or resources that contain subject matter that deals with manufacturing, 
distributing, or obtaining illegal drugs, alcohol, or other controlled substances. Sites that 
depict drug or alcohol paraphernalia and/or include methods for obtaining or 
manufacturing them. Does not include sites that provide information on prescription 
medications except those sites that describe how to obtain them illegally. 

 Email Sites or resources that provide access to email services and applications. 

 Employment/Career Sites or resources that allow the posting of jobs or resumes. Sites that provide 
information on compensation in specific fields or regions. Sites that post information 
about jobs and job openings. 

 Family Resources Sites or resources that provide family counseling, family safety tips, parenting 
information and tips, and family planning. 

 Financial/Stocks Sites or resources that provide information about finances, financial planning, 
insurance, stock tickers, and stock reports. Sites that allow the sale and purchase of 
stock. Includes banks and credit unions and credit rating and reporting sites. 

 Gambling Sites or resources that allow a person to wager money on online games with the 
expectation of winning money or prizes. Sites that contain links to other gambling sites 
or provide information on gambling strategies or tactics. 

 Games Sites or resources that provide access to online or downloadable games or discussions 
about games. Sites that provide information about game cheats. 

 Government Sites or resources that are specific to local, state, or federal government organizations 
or agencies, including political party sites and specific, official political sites. Sites 
ending in .gov. 

 Hate/Violence Sites or resources that promote or depict violence against persons, animals, property, 
or nations. Sites that single out groups for violence based on race, religion, or creed. 

  Health/Medicine Sites or resources that deal with or provide information on mental or physical health 
issues. Sites that allow the online purchase of prescription medications. 

  Illegal Activities Sites or resources that provide information about the manufacture, alteration, or sales of 
weapons. Sites that promote or depict disorderly conduct or that provide information on 
the manufacturing of explosives and explosive devices. 

  Instructional Sites or resources that contain instructional material, tutorials, or how-to pages. 

  Intimate Apparel Sites or resources that display models wearing underwear, lingerie, or other suggestive 
or see-through attire, including swimsuits. 

 Kids Sites or resources intended for children, including entertainment, education, crisis 
counseling, and kid-friendly communities. 

 Music/Entertainment Sites or resources that provide access to free downloadable or for-pay online music and 
video files such as MP3, WAV, MPG, and AVI. Sites that sell music or videos or that are 
dedicated to the music or entertainment industry. Sites that provide information on TV 
programs and programming, including movie review sites. 

 News Sites or resources that provide live, recorded, or written reports or editorials about 
current events. 

 Other Sites that do not fit into any of the existing Net Nanny categories. 

  Personals Sites or resources that contain personal ads, personal info pages, and personal portals. 

  Pornography Sites or resources that are meant to sexually arouse the viewer. May show models or 
real people that are engaged in erotic behavior intended to cause sexual excitement. 
May describe sexually explicit activities or contain sexually explicit material including 
images, movies, or text. Sites could be considered X-rated. 
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Category Description 

  Religious Sites that provide information on specific religions or religious beliefs. Regional religious 
organizational sites and sites built to promote religious groups, activities, and 
membership. 

 Schools/Colleges Sites or resources that contain information dealing with colleges, schools, seminars, or 
courses. Sites that end in .edu. 

 Search 
Engines/Portals 

Sites or resources that provide mechanisms for searching the Internet by specific words 
or phrases and that display the results as either links or images. Sites that allow a user 
to customize the look or content and that are geared to providing a "starting" place on 
the Internet. 

 Shopping Sites or resources that provide access to online malls, catalogs, or auctions, including 
classified ads. Department store sites, retail store sites, or sites that have coupons for 
free or discounted items. 

 Sports Sites that promote, advertise report on, or are associated with sports teams, individuals, 
or organizations. Sites that are involved with fantasy sports. Sites for organizations 
whose main focus is to report on amateur, college, or professional sports. 

 Travel Online resources that provide information on travel, such as destination descriptions, 
ticketing, and reservation sites; airline, bus, or train company sites; and car rental sites. 

 Work Related This category allows an organization to add URLs for sites that are used by their 
organization in the course of doing business. It may initially be blank. 

Note: If you set Pornography to Block or Warn, Net Nanny™ forces a “safe search” for as many search engines 
as it can. Currently, ContentWatch can force a safe search for the following search engines: Yahoo!, Google, 
AltaVista*, DogPile*, Lycos*, AllTheWeb*, and MSN. To bypass the safe search, you must temporarily disable 
Net Nanny via its system tray icon’s right-click menu. 
 
 
Block and Warning Messages 
When you define a user’s filter settings, you determine what level of access that user has to predefined Internet 
content categories. User access to these sites can be set to Allow, Warn, or Block. Following are examples of 
the Block and Warning messages Net Nanny displays when users access sites with a warning or blocked status. 
 

Warning Messages 
When a user attempts to connect to a site with a warning status, Net Nanny notifies the user that the URL has a 
warning status and it lists the site’s associated content category:  

 
The user can click Continue to view the requested page or Back to return to the previous Web site. The action 
is reported if reporting is enabled. For more information, see Enabling Reporting on page 53. 
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Block Messages 
When a user attempts to connect to a site with a blocked status, Net Nanny notifies the user that the URL is 
blocked and it lists the site’s associated content category:  

 
The requested Web site does not open. The user can click Back to return to the previous Web site. The action is 
reported if reporting is enabled. For more information, see Enabling Reporting on page 53. 

Block Messages with Override Option 
If a user has override privileges, Net Nanny allows the user to override blocked content. Net Nanny notifies the 
user that the URL is blocked and it lists the site’s associated content category: 

 
The user can click Override to enter the override password and view the requested Web site, or Back to return 
to the previous Web site. For some Web sites, the user might need to enter the override password more than 
once to view the content. 

Note: To give a user override privileges, you must select the Override Blocked Messages option in the user’s 
Profile Settings. For more information, see Defining User Profiles on page 27. 

The action is reported if reporting is enabled. For more information, see Enabling Reporting on page 53. 
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Block or Warning Messages with Request Override Option 
If a user has override request privileges, Net Nanny lets the user submit requests to Net Nanny administrators to 
unblock or recategorize specific Web pages or entire Web sites that fall under a blocked or warning category: 

  

To submit a Web Override Request, the user must perform the following in the Blocked or Warn dialog: 

1. Click Request Override to display the override request dialog. 

2. From the As drop-down list, select a suggested action (for example, allow the content or assign it to a 
new category). 

3. From the Apply Rule To drop-down list, select whether the action should be applied to the Web page 
alone or to the entire Web site. 

4. Click Send Request to submit the request to a queue in the Net Nanny Admin Tools, where a Net 
Nanny administrator can choose to accept or reject the request. 

For information on how Net Nanny administrators can process override requests, see Processing 
Override Requests on page 50. 

Note: It is also possible to click Apply Now (instead of Send Request) to immediately unblock or 
recategorize the Web page or Web site. To apply the override immediately, specify an administrative 
user name and password when prompted. The filter settings are immediately updated for the user 
currently logged in to Net Nanny. The next time the user visits the Web page or Web site, the new 
settings are in effect.   

Note: To give a user override request privileges, you must select the Request Overrides option in the user’s 
profile settings. For more information, see Defining User Profiles on page 27. 

The action is reported if activity reporting is enabled. For more information, see Enabling Reporting on page 53. 

Denying or Allowing Access to Internet, Instant Messaging, Newsgroup, 
and Peer-to-Peer Services 
To manage a user’s access to the Internet, instant messaging, newsgroups, or peer-to-peer services:  

1. Sign in to the Admin Tools. 

2. From the User List, select an existing user profile, then click Filter Settings. 

In Default Mode, click Filter Settings. 
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3. Under Allow Access To, select the services you want the user to be able to use. 

  
 
4. When finished, click OK to apply your settings.  
 

The following table lists the specific services supported under each category: 
 

Service Category Target Services 

Internet URLs, normal “surfing” or “browsing” 

Instant Messaging Google Talk, Yahoo!, AOL Instant Messenger (AIM*), MSN, QQ 

Newsgroups NNTP (standard newsgroups) 

Peer-To-Peer Gnutella, BitTorrent*, Kazaa*, eMule*, and eDonkey* 

Denying or Allowing Access to Internet Games 
To manage a user’s access to network games:  

1. Sign in to the Admin Tools. 

2. From the User List, select an existing user profile, then click Internet Games. 

In Default Mode, click Filter Settings. 

3. Select the games you want the user to be able to access. 

 
 

4. When finished, click OK to apply your settings. 
 

Note: To have access to Internet games, the user must be allowed to access the Internet. For information on 
giving the user access to the Internet, see Denying or Allowing Access to Internet, Instant Messaging, 
Newsgroup, and Peer-to-Peer Services on page 39. 
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 Managing Time Controls 
Time Controls allow you to manage the time of day and the amount of time that each user spends on the Internet. 
Each day of the week is divided into 30-minute chunks that can be set to allow (green) or block (red) Internet 
access.  

 
By default, Internet access is allowed at all times. If you define a Time Control for a user, the restriction applies 
to all Internet activity such as Internet surfing, instant messaging, newsgroups, peer-to-peer, and network 
gaming.  

Defining Time Controls  
To define user Time Controls:  

1. Sign in to the Admin Tools. 

2. In User Mode, select an existing user profile from the User List, then click Time Controls. 

In Default Mode, click Time Controls. 

3. Select the control you want to apply (Allow or Block). 

4. In the time grid, click-and-drag to apply the control to a specific time frame. 

Remember that a red rectangle indicates Internet access is not allowed during the corresponding time of 
day. A green rectangle indicates that Internet access is allowed during the corresponding time of day. 

5. To apply blanket settings, do one of the following: 
• Click Reset All to Allow to remove all “Block” time controls and allow Internet access at all times. 
• Click Reset All to Block to completely block Internet access. 



 

 
ContentWatch, Inc. / Net Nanny Parental Controls User Guide 

 Page 42 

To limit the total number of hours a user can spend on the Internet over a given period, regardless of the 
controls that have been specified in the time grid, do the following: 

a. Under Time Allowance, select Allow. 

b. In the field to the right of the Allow check box, enter the number of hours the user is allowed to 
access the Internet. 

c. From the Hours Per drop-down menu, select the period (Day or Week) that the specified amount of 
hours applies to. 

6. When finished, click OK to apply your changes.  

Enforcing Time Controls 
When a time control is in effect, ContentWatch™ displays a message when the user attempts to access the 
Internet. If a user has override privileges, the user can click Override and enter the override password to 
override the blocked connection. The password used to override time restrictions is the same password used to 
override a blocked Web site. 

  
Note: To give a user override privileges, you must select the Override Blocked Messages option in the user’s 
Profile Settings. For more information, see Defining User Profiles on page 27. 

If the user overrides the time control, Internet access is allowed for the next 30-minute block, after which the user 
must again override the blocked connection to maintain Internet access. 
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 Managing System Passwords 
During installation, the administrator creates override and uninstall passwords. 

The override password is used to override blocked content. Any user or administrator with override privileges 
must enter the override password to override blocked content. 

The uninstall password is required to uninstall Net Nanny™.  

Changing the Override Password 
There is only one override password. Therefore, if the administrator changes the override password, it is 
changed for everyone with override privileges. 

To change the override password: 

1. Sign in to the Admin Tools. 

2. Under Family Settings, click Passwords. 

3. Under Block Override, type and confirm the new password.  

 
Passwords are not case sensitive and must be between 3 and 13 characters in length. Numbers and 
letters can be combined. 

4. Click OK to save your changes. 

Important: After you change the override password, you must distribute the new password to all users who have 
override privileges. 
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Changing the Uninstall Password 
To change the uninstall password: 

1. Sign in to the Admin Tools. 

2. Under Family Settings, click Passwords. 

3. Under Uninstall, type and confirm the new password.  

 
Passwords are not case sensitive and must be between 3 and 13 characters in length. Numbers and 
letters can be combined. 

4. Click OK to save your changes. 
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 Working with Overrides 
Creating Web Address Overrides 
When a user enters a URL address in the browser, Net Nanny™ processes the requested page to determine 
which content category it belongs to. However, the administrator can bypass this default process by manually 
allowing or blocking a specific site, or the administrator can assign a URL to a predefined content category so 
the filter settings (Allow, Warn, or Block) for that category are then applied to the Web site. 

Note: See Content Categories on page 35 for a list of the predefined content categories. 

To illustrate this point, let's consider the following example: 

There is a community resource section accessible through the ContentWatch™ Web site. Because this section 
contains many educational articles that deal with the problems caused by pornography (and which, therefore, 
contain some adult content), normal filters (ours included) block this site as Pornography. After going to the site 
and examining the content, it is clear that it is not pornography and the administrator may wish to allow this site. 

Let's assume you want to categorize the URL www.contentwatch.com under Family Resources. In the Web 
Address field, type the URL www.contentwatch.com. From the Change To drop-down list, select Family 
Resources. From the Apply Rule To drop-down list, select whether to apply the override to just the 
www.contentwatch.com Web page or to the entire ContentWatch Web site. 

Note: To be sure that this site is allowed under Family Resources, the administrator must go to Filter Settings 
and make sure that Family Resources is set to Allow.  

 
 

The site is now categorized as a Family Resources site and access is allowed.  

Warning: If the administrator manually assigns a site’s content category, the system bypasses all automated site 
analysis. This means that if the site content changes, Net Nanny cannot determine the new category. Therefore, 
use this feature with care. 
 

http://www.contentwatch.com/
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To create an override for a Web address: 

1. Sign in to the Admin Tools. 

2. Under Family Settings, click Overrides. 

3. Click the Web Addresses tab. 

4. In the Web Address field, type the URL you want to override. 

 
Note: You can copy the URL from the browser and paste it in the Web Address field for accuracy. 
Always include the prefix “www,” for example, www.contentwatch.com. 

5. From the Change To drop-down menu, you can do any of the following:  

• Select Allow to always allow the site.  

• Select Block to always block the site.  

• Select a content category to apply to the site.  

Note: The content category’s Filter Settings apply to the site. 

6. From the Apply Rule To drop-down menu, select whether to apply the override just to the home page of 
the Web site entered in the Web Address field or to the entire Web site. 

7. Click Add.  

The URL is added to the list with its availability or category listed under Internet Access. 

8. Click Close to close the Overrides window. 

 

http://www.contentwatch.com/
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Creating Application Overrides 
The Net Nanny application override feature helps you work around conflicts that may arise between Net Nanny 
and other Internet-enabled software on your system. For example, Net Nanny may block some applications that 
require Internet access, such as online games or financial software. You can create overrides for such 
applications so that Net Nanny does not interfere with them when they try to access the Internet. 

To create an override for an application: 

1. Sign in to the Admin Tools. 

2. Under Family Settings, click Overrides. 

3. Click the Applications tab. 

  
 
4. Select one of the following methods to select the override application: 

Method 1: Manually browse to the application executable. 

a. Click Browse All. 

b. Browse to the location of the application’s executable file (<file name>.exe) on your computer’s 
hard drive. 
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c. Select the file, then click Open. 

 
 
d. When the executable’s name appears in the Application field, click Add to add the application to 

the overrides list.  
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Method 2: Select the application from a list of executables that have entries in the Windows Registry 
(in other words, applications that were formally installed in Windows via a setup wizard). 

a. Click Browse Installed. 

b. In the Installed Applications dialog, select the desired executable, then click Add Selected. 

Tip: You can select multiple executables at once by holding down the Ctrl key (to select 
nonadjacent items) or the Shift key (to select blocks of items), then clicking the desired 
executables. 

 
 The selected executables are added immediately to the application overrides list. 
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5. (Optional) Remove an application’s override. 

a. From the application overrides list, select the override you want to remove. 

b. Click Delete. 

  
 

6. When you are finished adding and removing application overrides, click OK to close the Overrides 
screen. 

 
Processing User Override Requests 
Users who have been granted override request privileges can submit requests to Net Nanny administrators to 
unblock or recategorize specific Web pages or entire Web sites that fall under a blocked or warning category. An 
administrator can review these requests in the Net Nanny Admin Tools (on the User Requests tabbed page of 
the Overrides window) and decide on a case-by-case basis which requests to accept or reject. 

To process users’ override requests: 

1. Sign in to the Admin Tools. 

2. Under Family Settings, click Overrides. 
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3. Click the Override Requests tab. 

  
 

4. Review the list of requests, such as who sent the requests, which Web addresses the requests are 
about, and what actions are being proposed. 

You can click the hyperlinks in the Web Address column to open requested Web sites in a browser and 
review their content. Also, before accepting a request, you can change the action or category the user 
has requested by selecting a different option from the appropriate Requested Action drop-down menu. 

5. To process a request, do the following: 

a. Click the request’s Select check box. 
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b. Click Accept Selected or Reject Selected. 

The new settings take effect immediately. 
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 Generating Usage Reports 
Two different reporting options are provided with Net Nanny™: 

• The default reports, or local reports, are located on the computer where Net Nanny is installed. You can 
view local reports to see Internet activity on the local computer.  

• The Web-based reporting option is available from the ContentWatch™ Web site. Web reports give the 
administrator the ability to check the content that is viewed on all computers where Net Nanny is 
installed.  

Enabling Reporting 
Net Nanny can report Internet usage for the entire system or for individual users. It retains activity data on the 
local computer for up to 30 days.  
 
Note: To view individual user reports: 

• The system must be in User Mode.  

For information on putting the system in User Mode, see Enabling User Mode on page 25. 

• Reporting must be enabled for each user.  
 
To view system usage reports in Default Mode or for individual users in User Mode, the Web and instant 
messaging reporting options must be enabled as follows: 
 

1. Sign in to the Admin Tools. 

2. In User Mode, select an existing user profile from the User List, then click Filter Settings.  

In Default Mode, click Filter Settings.  

3. To enable reporting on system-wide Web activity, select Web. 

4. To enable reporting on system-wide instant messaging activity, select Instant Messaging.  

5. When finished, click OK to save your changes. 

  



 

 
ContentWatch, Inc. / Net Nanny Parental Controls User Guide 

 Page 54 

Local Reporting 
Net Nanny provides comprehensive local reporting for Web activity and instant messaging. Each chart has drill-
down capability to view transaction detail. Local reports are accessible to the administrator on the computer 
where Net Nanny is installed.    

Accessing Local Web Activity Reports 
Local Web reports display Web activity for administrators and users on the local system. You must generate 
local Web reports on the computer where Net Nanny is installed. 

Important: To view individual user reports, the system must be in User Mode and the Web option must be 
selected in the user’s Filter Settings menu. For more information, see Enabling Individual Usage Reporting on 
page Error! Bookmark not defined.. Also, you must have Macromedia* Flash* Player installed to view the 
reports. You can download Flash Player from www.macromedia.com. 
 
To access local Web activity reports: 

1. Sign in to the Admin Tools. 

2. Under Family Settings, click Reports. 

3. From the Date Range drop-down list, select the desired date range. 

  
4. In the Report On drop-down list, select Web, then click OK.  

 
Net Nanny displays report graphs with drill-down capability for the following categories: 
• Web Time Summary 
• Web Time Summary by Day 
• Web Categories Visited 
• Web Filter Actions

http://www.macromedia.com/
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5. Select a user, date range, Web category, or filter action to generate charts with report transaction detail.  

6. To view additional report data, such as URLs, left-click a specific graph. 
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Accessing Local Instant Message Reports  
Instant message reports allow the administrator to view the content as well as the time spent in instant 
messaging activity for administrators and users on the local system.  

Important: To view individual user reports, the system must be in User Mode and the Web option must be 
selected in the user’s Filter Settings menu. For more information, see Enabling Individual Usage Reporting on 
page Error! Bookmark not defined.. Also, you must have Macromedia Flash Player installed to view the 
reports. You can download Flash Player from www.macromedia.com. 

To access local instant message reports: 

1. Sign in to the Admin Tools. 

2. Click Reports. 

3. From the Date Range drop-down list, select the desired date range. 

  
 
4. From the Report On drop-down list, select IM and click OK.  

 
 
Report graphs with drill-down capability are displayed for the following categories: 

• Instant Message Time Summary 

• Instant Message by Day 

• Instant Message Services Utilized 
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5. Select a user, date range, and access type (Instant Message) to generate charts with report transaction 
detail.  
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Web-Based Reporting (Internet or Instant Messaging) 
Web reports give the administrator the ability to check the content that is viewed on all computers where he or 
she has installed Net Nanny.  

Web reports give the administrator access to information in the following categories: 

• Time Spent Online 

• Web Usage 

• Content Categories 

• Filter Actions 

Each chart within Web reporting has drill-down capability for further detail. Selecting a user, date range, and 
access type (Web) generates charts that report transaction detail. 

Warning: If you access reports from a remote computer that does not have Net Nanny installed and you open a 
site that a user accessed or one that was blocked, content is not filtered. 

Net Nanny provides comprehensive Web-based reporting for both Web and instant message usage. Web-based 
reports allow the administrator to view reports for each user or the entire family. Each chart within these reports 
has drill-down capability for further detail. Selecting a user, date range, and access type (Web or Instant 
Message) generates charts that report transaction detail.  

Enabling Web-Based Reporting 
Access to Web-based reporting is disabled by default and must be enabled by the administrator on a per-user 
basis.  

To enable a user’s access to Web-based reporting: 

1. Sign in to the Admin Tools. 

2. In User Mode, select an existing user profile from the User List, then click Filter Settings.  

If in Default Mode, click Filter Settings. 

3. Select the Remote Reporting option.  

 
 

4. When finished, click OK to apply the setting.  
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Accessing Web-Based Reporting (Internet or Instant Messaging) 
You can access Web-based reporting from the computer where Net Nanny is installed or from any computer with 
Internet access and a browser. 

To access Web-based reporting:  

1. Select an access method: 
• Local access method: Right-click the Net Nanny icon  in the system tray located on the taskbar 

at the bottom of your Windows desktop, then select Remote Management to be redirected to the 
manage.netnanny.com Web site. 

 
• Internet access method: Within a Web browser, go to manage.netnanny.com. 

2. Complete the sign-in information, then click Login. 

You can enter the email address and password for the administrator account created during installation 
or any user account with administrator rights.  

 
 

3. Select a name from the Users list, then click Reports. 
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4. Choose the report Date Range. 

  
Note: There can be a delay (up to 24 hours) between user activity and time that an action is reported on 
the Web-based reports.  

5. Select Web or IM to generate a Web or instant messaging report. 

 

6. Click Refresh to get the latest report. 
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 Managing Net Nanny with Remote Management 
Remote Management gives the administrator the ability to view and change all administrative settings from any 
computer with an Internet connection and a browser. This allows the administrator to remotely disable or enable 
access to specific Net Nanny™ categories and services or even deny all Internet access. 

For the changes to immediately take effect, the administrator must log on to the computer where Net Nanny is 
installed, right-click the system tray icon, then select Refresh Profiles. Otherwise, the settings are updated 
sometime within the next 24 hours. Changes made in remote management are reflected in Net Nanny under 
User and Family Settings.  
 

Accessing Remote Management 
Remote Management provides the administrator with access to all administrative functions in Net Nanny from 
any computer with an Internet connection and a browser.  

To access Remote Management:  

1. Select an access method: 
• Local access method: Right-click the Net Nanny icon  in the system tray located on the taskbar 

at the bottom of your Windows desktop, then select Remote Management from the quick menu. 

              
• Internet access method: Within a Web browser, go to manage.netnanny.com. 

2. Complete the sign-in information, then click Login. 
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3. Select a user from the Users list to change or manage the settings, then choose which settings or 
services you want to access from the menu across the top of the screen. 

 

 
 
 
Changing Account Settings 
Account settings such as your family name, block override, and install and uninstall passwords can be changed 
through Remote Management. 

To change account settings through Remote Management: 

1. Access Remote Management.  

For details on Accessing Remote Management, see page 61. 

2. Select your family name at the top of the Users list. 

  

Select 
user 

Choose 
settings or 
services to 

access. 
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3. Change the Family Display Name; the Block Override, Install, or Uninstall Passwords; the Client 
Updates method; the Time Zone; or the display status of the ContentWatch system tray icon. 

  
The install password can be used in place of the administrator’s password to install Net Nanny as an 
existing user. The install password is provided so the administrator can allow other family members to 
install Net Nanny without giving them the administrator password. The install password is used only 
during installation as an existing user. 

The Client Updates option allows you to choose the delivery method for Net Nanny client software 
updates. If you choose Manually, updates are downloaded only when you right-click the Net Nanny icon 

 in your system tray, then click Check for Updates. If you choose Automatically, the client 
automatically downloads and installs any available updates when you connect to the Internet. If you 
choose Password Required, a Net Nanny administrator must enter his or her password to manually 
download and install client software updates. 

4. When finished, click Save Changes to apply your settings. 
For the changes to immediately take effect, the administrator must log on to the computer where Net 
Nanny is installed, right-click the Net Nanny icon  in the system tray, then click Refresh Profiles. 
Otherwise, the settings are updated sometime within the next 24 hours. Changes made in Remote 
Management are reflected in Net Nanny under User and Family Settings. 
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Notifications 
Email notifications can be sent to the administrator or other users to provide alerts about users who have been 
blocked or warned or who have chosen to override blocks. 

To set or change email notifications through Remote Management: 

1. Access Remote Management.  

For details on Accessing Remote Management, see page 61. 

2. Select your family name at the top of the Users list, then click Notifications. 

  
3. Enter the email address where you want to send notification messages. 

4. Select the user you want to receive notification messages about.  
• If your system is in Default Mode, select your family name.  
• To receive notification for a specific user’s activity, select the user profile.  

5. Select if you want a notification sent when the user is blocked or warned, or if the user overrides a block 
or requests an override.  
You may select multiple options. 

6. Click Add to save the notification to the Notification List. 

  
 
7. Repeat Steps 4-7 for each notification you want to add to the Current Notifications list.  

8. When finished, click Save Changes to apply your settings. 

 
For the changes to immediately take effect, the administrator must log on to the computer where Net 
Nanny is installed, right-click the Net Nanny icon  in the system tray, then click Refresh Profiles. 
Otherwise, the settings are updated sometime within the next 24 hours. Changes made in Remote 
Management are reflected in Net Nanny under User and Family Settings.  
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Reports (Family Level) 
Reports can be viewed for either Internet activity or instant messaging. Accessing Remote Management reports 
on the family level gives the administrator an overview of how the family as a whole is spending time on the 
Internet. 

Important: ContentWatch™ servers store up to 14 days of activity data. Local reports can provide data for up to 
30 days of Web and instant messaging activity. 

To view family-level reports: 

1. Access Remote Management.  

For details on Accessing Remote Management, see page 61. 

2. Select your family name at the top of the Users list.  

3. Click Reports. 

  
 
4. Select the report Date Range. 

  
Note: There can be a delay (up to a 24 hours) between user activity and the time that an action is 
reported on the Web-based reports.  

5. Select Web or IM to generate a Web or instant messaging report. 

 

6. Click Refresh to get the latest report. 
 
 

Web Overrides 
Overrides can be set or changed to allow, block, or categorize a specific URL with Remote Management. If an 
address is set to Allow, the user sees no message and the site is displayed on screen. If a site is set to block, a 
block message appears. Depending on the user settings made by the administrator, the user may be able to 
override this block with a password. The administrator may also select a category to define a specific URL. Net 
Nanny is then set to allow, warn, or block the user according to filter settings. 

To configure Web overrides through Remote Management: 

1. Access Remote Management.  

For details on Accessing Remote Management, see page 61. 

2. Select your family name at the top of the Users list. 
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3. Click Web Overrides. 

  
 
4. In the Web Address field, type a specific URL. 

5. From the Change to drop-down menu, select an action or category. 

6. From the Apply Rule To drop-down menu, select whether to apply the rule to the entire Web site or just 
the home page of the specified Web site. 

7. Click Add to complete the override. 

  
 
 

Application Overrides 
The Net Nanny application override feature helps you work around conflicts that may arise between Net Nanny 
and other Internet-enabled software on your system. For example, Net Nanny may block some applications that 
require Internet access, such as online games or financial software. You can create overrides for such 
applications so that Net Nanny does not interfere with them when they try to access the Internet. 

To create an override for an application through Remote Management: 

1. Access Remote Management.  

For details on Accessing Remote Management, see page 61. 

2. Select your family name at the top of the Users list. 

3. Click Bypass List. 

  
 
4. Choose a method for locating the application executable you want to create an override for: 

Method 1: Browse to the application executable. 

a. Select the By Browsing option. 
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b. Click Browse. 

 
c. Browse to the location of the application’s executable file (<file name>.exe) on your computer’s hard 

drive. 

d. Select the file and click Open. 

 
 

e. When the executable’s full filename (including the local path to the file) appears in the By Browsing 
field, click Add to add the application to the overrides list.  
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Method 2: Enter the filename of the application’s executable file.  

a. Select the By Entering Name option. 

b. In the accompanying field, type the exact filename of the application’s executable file. 

c. Click Add to add the application to the overrides list. 

 
 

5. To remove an application’s override, do the following: 

a. In the application overrides list, click the executable’s Delete check box. 

b. Click Delete Selected. 
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Requested Overrides 
Users who have been granted override request privileges can submit requests to Net Nanny administrators to 
unblock or recategorize specific Web pages or entire Web sites that fall under a blocked or warning category. An 
administrator can review these requests in Remote Management and decide on a case-by-case basis which 
requests to accept or reject. 

To process users’ override requests: 

1. Access Remote Management.  

For details on Accessing Remote Management, see page 61. 

2. Select your family name at the top of the Users list. 

3. Click Requested Overrides. 

  
 
4. Review the list of requests, such as who sent the requests, which Web addresses they are making the 

requests about, and what actions they are proposing. 

  
You can click the hyperlinks in the Web Address column to open requested Web sites in a browser and 
review their content. Also, before accepting a request, you can change the action or category the user 
has requested by selecting a different option from the appropriate Requested Action drop-down list. 

5. To process a request, do the following: 

a. Click the request’s Select check box. 

 
 

b. Click Accept Selected or Reject Selected. 

The new settings take effect immediately. 
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Login Type 
There are two login types for the Net Nanny client: User and Default. If the administrator chooses Default Mode, 
no password is required to log in to the client. If the administrator selects User Mode, each user must log in to 
the client before they can access the Internet. 

To change the login type: 

1. Access Remote Management. For details on Accessing Remote Management, see page 61. 

2. Select your family name at the top of the Users list. 

3. Click Login Type. 

 
 
4. Select the desired login type. 

 Choose Default if users are not required to log in to the client before they can access the Internet and 
instant messaging. Default Mode provides ease-of-use; however, it does not separately monitor each 
user’s Internet usage, and filters are unilaterally applied to all users.   

 Choose Users to require each user to enter a password to log in to the client. 

  
 
5. When finished, click Save Changes to apply your settings. 

For the changes to immediately take effect, the administrator must log on to the computer where Net 
Nanny is installed, right-click the Net Nanny icon  in the system tray, then click Refresh Profiles. 
Otherwise, the settings are updated sometime within the next 24 hours. Changes made in Remote 
Management are reflected in Net Nanny under User and Family Settings.  

Adding and Removing Users 
To add a user in Remote Management: 

1. Access Remote Management. For details on Accessing Remote Management, see page 61. 

2. Select your family name at the top of the Users list, or select an existing user. 

3. Click Add User. 
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4. From the Duplicate Settings From drop-down menu, select Factory Settings. 

  
 
5. Complete the user profile information (email address, password, display name, etc.), then click OK. 

For a description of the options in the Add User screen, see User Profile Options on page 71.  

After you create the user profile, you can define the filter settings and time controls for the user. For more 
information, see Filter Settings on page 73 and Time Controls on page 74. 

User Profile Options 
The following table outlines the user profile options in the Add User screen in Remote Management: 
 

Field Description 

Email The user’s email address.  

This field is required only if the user is an administrator. 

Password The password the user enters to sign in to Net Nanny.  

Passwords must be between 3 and 13 characters in length. Passwords are case 
sensitive. Numbers and alpha characters can be combined. 

Passwords are required only for administrators. If you prefer not to have a password for a 
user, or if a user is too young to type in a password, leave the password field blank. 

Note: We recommend you keep a list of passwords and the corresponding user names in 
a safe place for reference. However, the administrator can change a password for any 
user, at any time, which eliminates the fear of losing or forgetting passwords for access. 

Display Name The name the user selects to sign in to Net Nanny. 

Display names must be between 2 and 20 characters in length. 

Inactive User 
Logout 

Designates an inactivity threshold after which the user is automatically logged out. 

If you select Never, Net Nanny does not automatically log out the user. 

 

Administrator Gives the user administrative privileges.  

Users with administrative privileges can change passwords, profile settings, and filters; 
receive email notifications; and access reporting and remote management. 
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Field Description 

Override Blocked 
Messages 

Lets the user override blocked content. If selected, Net Nanny prompts the user for the 
override password when it blocks Internet content. (For an example of this message, see 
Block and Warning Messages on page 37.) 

Important: The user must enter the override password before Net Nanny displays the 
blocked content. The override password is created during installation and can be 
changed at anytime through the Passwords dialog. 

If you do not select this option, Net Nanny displays a block message when the user tries 
to access blocked Internet content. 

Auto Client Login Select this option if you want Net Nanny to remember the profile's user name and 
password and to automatically log in to Net Nanny using this profile whenever a user 
attempts to access Internet content. 

When this option is selected, you only need to log in to Net Nanny once. Thereafter, Net 
Nanny no longer prompts for login credentials when users attempt to access Internet 
content, even if the computer is rebooted. Net Nanny continues to remember the user 
name and password until someone manually logs off the Net Nanny profile. 

Note: The Auto Client Login option is useful when you want to monitor and manage 
Internet activity for a single computer rather than specific users. For example, if you have 
a computer in your living room and you want to use the same Net Nanny filter settings, 
time controls, and so forth to control Internet access for anyone who uses that computer. 
You can create a Net Nanny profile named "Living Room," configure profile settings as 
desired, and then enable the Auto Client Login option so that users are automatically 
logged in to Net Nanny whenever they start that computer and try to access the Internet. 

 

To remove a user from Remote Management: 

1. Access Remote Management.  

For details on Accessing Remote Management, see page 61. 

2. From the Users list, select the user you want to remove. 

3. Click Remove User. 

  
 
4. Click Yes to confirm you want to remove the user. 

  
 
 Note: You cannot delete a user who is currently logged in to Remote Management. 
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Filter Settings 
With Remote Management, the administrator can change all filter settings from a location other than his or her 
local computer. Categories can be set to allow, warn, or block. Access can be allowed or denied for Web, peer-
to-peer, newsgroups, or instant messaging. Activity reporting for Web, instant messaging, and remote reporting 
can be turned on or off. 

To modify filter settings: 

1. Access Remote Management.  

For details on Accessing Remote Management, see page 61. 

2. Select a user from the Users list. 

3. Do one of the following: 

• Select Allow, Warn, or Block from the drop-down list for each content category whose setting you 
want to change: 

        
• Select a setting from the Set All Categories To drop-down list to change all content categories to the 

same setting: 

        
4. In the Allow Access To section, select the services you want the user to be able to use (Web, Peer-to-

Peer, News Groups, or Instant Messaging). 

5. In the Allow Activity Reporting section, select the kinds of user activities you want to enable reporting on 
(Web or Instant Messaging) and whether you want the user to be able to view his or her own Web-based 
reports (Remote Reporting). 

6. When finished, click Save Changes to apply your settings. 

For the changes to immediately take effect, the administrator must log on to the computer where Net 
Nanny is installed, right-click the Net Nanny icon  in the system tray, then click Refresh Profiles. 
Otherwise, the settings are updated sometime within the next 24 hours. Changes made in Remote 
Management are reflected in Net Nanny under User and Family Settings.  
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Time Controls 
Remote Management gives the administrator the ability to control when Internet access is allowed or blocked. 
Internet access can be managed for specific days or times of day. Also, the administrator can impose a time 
allowance on the total amount of hours that users are allowed to access the Internet per day or week. 

To configure Time Controls: 

1. Access Remote Management.  

For details on Accessing Remote Management, see page 61. 

2. Select a user from the Users list, then click Time Controls. 

  
 
3. To limit the total number of hours a user can spend on the Internet per day or week: 

a. Under Time Allowance, select Enable. 

b. In the field to the right of the Enable check box, specify the amount of hours the user is allowed to 
access the Internet. 

c. From the Hours drop-down menu, select the period (Day or Week) that the specified amount of 
hours applies to. 

d. When finished, click Save Changes to apply your settings. 
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4. To set controls for specific days and times of day: 

a. From the Day drop-down list, select the days for which you want to set time controls. 

b. Define the Start Time and End Time for the time control.  

Select All Day to automatically select the entire day. 

c. From the Internet Access drop-down list, select whether Internet access is Allowed or Blocked 
during this time frame. 

Note: Remember that a red rectangle indicates Internet access is not allowed during the 
corresponding time of day. A green rectangle indicates that Internet access is allowed during the 
corresponding time of day. 

d. To apply blanket settings: 
• Click Reset All to Blocked to completely block Internet access. 
• Click Reset All to Allowed to remove all time controls and allow Internet access at all times. 

e. When finished, click Save Changes to apply your settings. 

For the changes to immediately take effect, the administrator must log on to the computer where Net 
Nanny is installed, right-click the Net Nanny icon  in the system tray, then click Refresh Profiles. 
Otherwise, the settings are updated sometime within the next 24 hours. Changes made in Remote 
Management are reflected in Net Nanny under User and Family Settings.  
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Profile Settings 
Remote Management allows the administrator to change all user profile settings (such as email address, 
password, and user display name). 

To modify user profile settings: 

1. Access Remote Management.  

For details on Accessing Remote Management, see page 61. 

2. Select a user from the Users list. 

3. Click Profile Settings. 

  
4. To change the user’s email address, type a new address in the Email field. 

5. To change the user’s Password, type a new password and confirm it. 

6. To assign a different display name to the user, type it in the Display Name field. 

7. From the Inactive User Logout drop-down list, select whether or not to automatically log out the user 
after a certain period of inactivity. 

8. Select the Administrator check box if you want to give the user administrative privileges. 

9. Select the Override Blocked Messages check box if you want to give the user override privileges. 

10. Select the Request Web Override check box if you want to allow the user to send requests to Net 
Nanny administrators to allow access to Web pages or Web sites that are currently blocked.  

11. Select the Auto Client Login check box if you want Net Nanny to remember the profile's user name and 
password and to automatically log in to Net Nanny using this profile whenever a user attempts to access 
Internet content. 

For more information on this option, see User Profile Options on page 28. 

12. Select the Auto Windows Login check box if you want Net Nanny to employ a user's Windows login 
credentials to automatically log in to their personal Net Nanny profile for Internet access..  

For more information on this option, see User Profile Options on page 28.  

13. When finished, click Save Changes to apply your settings. 
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For the changes to immediately take effect, the administrator must log on to the computer where Net 
Nanny is installed, right-click the Net Nanny icon  in the system tray, then click Refresh Profiles. 
Otherwise, the settings are updated sometime within the next 24 hours. Changes made in Remote 
Management are reflected in Net Nanny under User and Family Settings. 

 
 

Internet Applications and Games 
With Remote Management, the administrator can choose to allow or deny access to Internet applications and 
games on any computer where Net Nanny is installed. 

To control access to Internet applications and games: 

1. Access Remote Management.  

For details on Accessing Remote Management, see page 61. 

2. Select a user from the Users list. 

3. Click Internet Applications and Games. 

 
 

4. Select the games you want the user to be able to access.  
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5. When finished, click Save Changes to apply your settings. 

For the changes to immediately take effect, the administrator must log on to the computer where Net 
Nanny is installed, right-click the Net Nanny icon  in the system tray, then click Refresh Profiles. 
Otherwise, the settings are updated sometime within the next 24 hours. Changes made in Remote 
Management are reflected in Net Nanny under User and Family Settings.  

Reports (User Level) 
Reports can be viewed for Internet activity or instant messaging. Accessing Remote Management reports on the 
user level allows the administrator to access information about each computer where Net Nanny is installed. 

Important: ContentWatch servers store up to 14 days of activity data. Local reports can provide data on up to 30 
days of Web and instant messaging activity. 

To view user-level reports: 

1. Access Remote Management.  

For details on Accessing Remote Management, see page 61. 

2. Select a user in the Users list, then click Reports. 

  
 
3. Select the report Date Range. 

  
Note: There can be a delay (up to 24 hours) between user activity and the time that an action is reported 
on the Web-based reports.  

4. Select Web or IM to generate a Web or instant messaging report. 

 

5. Click Refresh to get the latest report. 
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 Glossary 
Administrative Privileges: Access rights that give a user the same level of access as an administrator. 

Administrator: Person who is responsible for setting up and maintaining a group of users. Duties of the 
administrator include installing Net Nanny, setting up and managing user profiles, and assigning passwords and 
privileges. 

Application: Software, program, or tool used on a computer, such as a word processor, game, or email 
program. 

Browser: The application that lets you navigate around and view pages on the Web. Netscape and Internet 
Explorer are the two most common. 

Category: General term for a whole topic or information type. 

Client-Based Filtering: Filtering that is performed from an individual computer. Filtering software and a list of 
categorized sites are stored on an individual computer, which makes filtering more flexible for the user making 
decisions about acceptable content. Aside from restricting Internet access to certain Web sites, many client-
based filters also offer controls for other Internet services. 

Default Settings: A setting that a program is preset to select (usually the recommended settings) if you do not 
specify other options. 

Drill Down: To move from a summary of information to more detailed data. To drill down through a series of 
reports addressing more detail at each level. 

Filtering: Controlling access to a Web page request by analyzing the incoming and outgoing requests and letting 
them pass or stopping them based on settings selected within Net Nanny. 

Guest Profile: A single, generic, limited profile set up for visitors and friends to use. 

Hacker: Slang term for an individual who tries to gain unauthorized access to computer systems for the purpose 
of stealing or corrupting data. 

Help: Online documentation. Many programs come with the instructional manual, or a portion of the manual, 
integrated into the program. If you encounter a problem or forget a command while running the program, you can 
access help documentation by selecting Help from the Menu bar, then clicking a topic. 

Icon: A small picture that represents an object or program. 

Instant Messaging: Real-time communication. Typed conversation that is received almost instantly as soon as it 
is sent. Talking live with one or more people via the Internet. It's like a telephone party line, except you type 
instead of talk. 

Internet: Countless networks of computers that are connected together across the world allowing millions of 
people to share information. Components of the Internet include the World Wide Web, newsgroups, instant 
message rooms, and email. 

Log: Program or system that enters a record into a log file or report file. 

Peer-to-Peer: Type of network that exists on the Internet which allows users to have access to other users' files 
residing on their hard disks. Net Nanny currently blocks peer-to-peer activity only on the Gnutella network. 

Portable User Profiles: Allows a user to install the filter on more than one computer and have settings 
transferred automatically. This is very useful for multiple-computer households or in a situation where a computer 
breaks down or is outdated and needs to be replaced. 

Remote Management: Capability of accessing files, devices, and other resources not connected directly to your 
workstation. In the case of Net Nanny, reviewing report results and managing user profiles can be performed 
from any computer having Internet access. 

Screen Name: Identifier that consists of a sequence of one or more alpha or numeric characters that uniquely 
identifies a person. 
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Server-Based Categorization and Validation: Method of content filtering in which a list of categorized URLs is 
maintained on a server and the server is updated regularly to ensure that all users are getting the most up-to-
date, accurate information. The server does not actually deliver the requested Web page (URL) to the customer 
but compares the requested URL to the list. Net Nanny uses this content filtering method. 

Shortcut Menu: Pop-up menu that appears by right-clicking an object. When left-clicking once or right-clicking 
the Net Nanny icon  from the System Tray located in the Taskbar, the same pop-up menu is displayed. 

System Tray: Located on the Windows Taskbar (usually at the bottom next to the clock). Contains miniature 
icons for easy access to system functions such as fax, printer, modem, volume, etc. 

Taskbar: System bar located at the bottom of the computer screen. Home base for the Start button, system 
clock, system tray, etc. 

Transaction Detail: Activity information based on report results. 

Tutorial: Interactive multimedia presentation that explains program features. 

URL: (Universal Resource Locator) Internet address that shows the specific path to a site or a document online. 
The URL for a Web page looks like this: http://www.domain name/folder name/filename 

User: Individual who uses a computer. 

User ID: Identifier that distinguishes a specific user in a program. 

User Profile: Program settings that are specific to an individual user. 

World Wide Web: (WWW) The visual component of the Internet. Created with HTML language, Web pages can 
include text, pictures, sound clips, video, links for downloading software, and much more. The Web is only one 
component of the Internet, although the terms are often (and mistakenly) interchanged. 

Web-Based Reporting: Reports that compile Web and instant message activity for a Net Nanny family and are 
accessible from any computer with Internet access (when enabled by the administrator). 
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 Frequently Asked Questions (FAQ) 
Can I be notified at work when my kids are trying to view inappropriate sites? 
As the administrator, you can specify an email address where you want to receive notices. You can set each 
profile to send a notice for one or all of the following: 

 When a user receives a warn message 
 When a user receives a blocked message 
 When a user overrides a block 

 
How do I get email notifications at work? 
Sign in to the Net Nanny™ Admin Tools. Under Family Settings, click Email Notifications. In the Send Email 
To field, type the email address where you want to receive notifications. Configure the types of notifications you 
want to receive, then click OK. 
 
Can I make changes to my child's profiles from work? 
Net Nanny gives you the unique ability to remotely manage all of your Net Nanny profiles and settings. Use your 
administrator email and password to sign in to the manage.netnanny.com Web site, then make the desired 
changes to the user profile settings. 
 
Can my children disable Net Nanny software? 
We have gone to great lengths to make sure that Net Nanny is difficult to bypass. A password is required to 
uninstall or make any alterations to settings. 
 
Do I have to change my ISP account to use Net Nanny? 
No, Net Nanny functions with most ISPs. Because Net Nanny is installed on your computer, it doesn't conflict 
with anything your ISP is doing. 
 
Does Net Nanny work with personal firewalls? 
Net Nanny is compatible with most popular, commercially available firewall software. Call Customer Support if 
you are having problems. 
 
How do I change the override password? 
Log in to the Net Nanny Admin Tools. Under Family Settings, click Passwords; then under Block Override, type 
a new password and click OK to save your changes. 
 
I can see the name of the site my children went to, but it doesn't really tell me what kind of site it is. 
Net Nanny online reports allow you to drill down into the details of each individual user to view their Internet 
transactions. The actual URL names that appear on the reports are live links that allow you to open and view 
each site. 
 
I have more than one computer--can I use the same settings on all of them? 
Yes, Net Nanny is very portable that way. By importing existing accounts during installation, the original settings 
follow you to each computer. This is also very useful when a computer needs to be replaced. During installation, 
select Existing User, then click Next. When prompted, enter your email address and password. Net Nanny 
imports all your account information. 
 
I have problems starting Yahoo Messenger after installing Net Nanny.  What do I do? 
In Yahoo Messenger, open the Preferences section and select the Connection category. Make sure that 
connection is set to Firewall with no proxies. You should then be able to connect. 
 
If I want another person to be an administrator too, how do I do that? 
Net Nanny allows you to assign as many administrators as you need. Sign in to the Net Nanny Admin Tools and 
select the user you want to assign administrative privileges to. Click Profile Settings, select the Administrator 
check box,, then click OK. After a user is assigned to be an administrator, he or she can open Net Nanny, view 
reports, and remotely manage profiles. 
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What if I forget my administrator password? 
If you forget the primary administrator password, you must do one of the following: 

• If you have more than one administrator account, another administrator can change your password for 
you by logging in to Admin Tools, selecting your user profile from the User List, and changing the 
password in the Profile Settings dialog. 

• At the Admin Tools login dialog, click Forgot Password. Your Web browser launches and takes you to 
the ContentWatch™ Web site where you are asked to enter the email address you specified when 
installing Net Nanny. An email is then sent to this address containing a link to a Web page that asks you 
the secret question you entered when you installed Net Nanny. When you type the secret answer, you 
are then allowed to change your password for this account. 

• Choose Remote Management from the System Tray icon and in the Web page that appears, click 
Forgot Password. You are prompted to enter the email address you specified when installing Net 
Nanny. An email is then sent to this address containing a link to a Web page that asks you the secret 
question you entered when you installed Net Nanny. When you type the secret answer, you are then 
allowed to change your password for this account. 

• Send a Password Request to info@contentwatch.com or call Customer Support at 1-800-485-4008. You 
must provide the following information to change the primary administrator password: 

o Administrator name 
o Registration key 
o Account name 
o Email address (where to send password) 
o Secret question and answer 
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 Open Code License Text 
 
PCRE License Text 
Regular expression support is provided by the PCRE library package, which is open source software written by 
Phillip Hazel, and copyright is by the University of Cambridge, England. 
ftp://ftp.csx.cam.ac.uk/pub/software/programming/pcre/ 
  
SOAP License Text 
This product includes software developed by the Apache Software Foundation. 
http://www.apache.org/ 
  
OpenSSL License Text 
This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. 
http://www.openssl.org 
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